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Logging In 
 
Start PedCath as you would any Windows program: Click the Start menu, and select PedCath from its own 
program group. 
 
Locating the Data Folder 

If this is the first time PedCath has been run on this computer, a 
message box will appear, telling you that PedCath could not locate the 
Data Folder.   Click OK and the Locate Data Folder screen will appear.  
Browse to locate your PedCath data files.   
 
When you have located the proper directory, the red light above “Files 
Found” will turn from red to green.  When the light is green, you are 
ready to proceed. Click OK. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Locate Data Folder Screen - Red Light   Locate Data Folder Screen - Green Light                    
 
 
Your Password 

After you have located the data files, the PedCath login Screen will appear.   
Enter the user login and the password given to you by your network 
administrator.   
 
The default password for new users is Taussig.  Once you have used the 
password to login, you must change it immediately, and will be prompted to do 
so by PedCath. 
  
 
Dr. Helen Brooke Taussig, often called the "mother of pediatric cardiology," was born in 1898. 
Dr. Taussig attended the medical school of Johns Hopkins University, where she became interested 
in cardiology. In 1930, she assumed leadership of the cardiology clinic at Johns Hopkins, where she 
encountered many "blue babies." She investigated the reasons for cyanosis and discovered that its 
major cause in cases of Tetralogy of Fallot was insufficient blood flow to the lungs.  
 
Dr. Taussig was a pioneer in devising surgical treatments for congenital heart disease. In 1944, the 
Blalock-Taussig Shunt operation, which she developed with surgeon Dr. Alfred Blalock, was first 
performed. The publication of this procedure revolutionized the medical approach to congenital 
heart disease. It also inaugurated the new specialty of pediatric cardiology and led to he saving of 
many thousands of lives in the decades to come.  
 
In later years, her failing hearing made Dr. Taussig rely increasingly on her sense of touch, using her hands to diagnose 
cases of congenital heart disease. Helen B. Taussig's contribution to pediatric cardiology was recognized through the 
bestowal of many honors, including the United States' Medal of Freedom, the French Chevalier Legion de la Legion 
d'Honneur, and the Italian Feltrinelli Prize. She died in 1986.       

 

Photo  Karsh, used 
with permission. 
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! After you log in, PedCath    opens to the browse screen, with snapshot views of every cath. 
 
 

The Browse Screen 
 
The patient list is located at the 
upper left part of the main screen.  
Each line shows a patient’s first 
and last names, and the hospital 
history number (MRN).  The cath 
list, in the upper middle, shows 
cath records that have been saved 
for the selected patient.  Each 
patient may have multiple cath 
records, which are identified in the 
list by date and the hospital’s cath 
number.  To the right side of the 
screen is the staff list, which shows 
the personnel involved in each cath, 
as well as their roles.   
 
The lower two thirds of the screen 
is devoted to a summary of the cath 
highlighted in blue in the cath list.  On the left there are patient diagrams.  In the middle are calculations derived 
from up to eight hemodynamic measurement sets.  On the right are any diagnoses or procedures that accompany 
the present cath, along with their codes.  Across the bottom are staff comments about the cath. 
 
To view a patient’s caths, either click on the patient’s name, or use the arrow keys and the “Page Up” and “Page 
Down” keys to locate the desired patient’s record. 

! To view a larger version of the diagram, double click on it. 
 
Sorting patients 
When you start, you will notice a blue frame around the patient list.  This indicates that the patient list is active.  
If you click on a cath record or staff record, the corresponding list will be highlighted. 
 
Records may be sorted in ascending or descending order by clicking on the appropriate column heading.  For 
example, to arrange patients by medical record number, click MRN in the gray box at the top of the patient list.  
A small arrow will appear next to MRN.  To reverse the order, click in the same place again.  Clicking on any 
of the gray field headings - Name, MRN, Cath Date, Cath No., Staff Name, or Role - will also provide quick 
sorting by field. 
 

Locating Patients 
When the patient list is sorted alphabetically, you may quickly jump to records with a specific 
beginning letter.  For example, if the patient list is sorted by name, typing S will highlight the first 

patient whose last name begins with an “S.”  Likewise, if the list is sorted by medical record number, typing 4 
will highlight the first patient with a medical record number beginning with “4”. For more detailed searches, 
there is a find function to locate a patient.  To access this function, press Ctrl+F [hold down the Ctrl key, press 
F, then release both], click on the binoculars on the toolbar at the top of the screen, click on the Find button 
below the patient box, or select “Find…” from the tools menu.  The find button will highlight the first patient it 
finds matching the search string you enter. 
 
Different views in the browse screen 
In the default view, cath records are sorted by patient.  In addition, cath records may be viewed two other ways.  
In the View menu at the top of the main window, you may select to view caths by date or by staff. 
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The Browse Screen Toolbar 
The toolbar is located at the top of the screen, just below 
the menus (File, Edit, View, Tools, and Help). 

! If you forget what a button does, you can find out by 

leaving the mouse over the button for a few seconds.  A 
label will appear with the name of the button. 
 

Editing patient demographics 
Clicking the Edit Patient button or the Edit 
Patient icon will pop-up the Patient Record 

Window.  
 
In this window, you may edit the patient name, MRN, 
date of birth, gender, social security number, and race.  
Any data with a bold label is a required field.  Any 
data you enter in this window will be automatically 
saved after you click OK.  

! Patient demographics may be edited by double 

clicking on the patient’s name.   
 
 
Adding new patients 

Clicking the Add Patient button or the Add 
Patient icon will pop-up an empty Patient Record 
Window. 

  
Editing staff records 

Clicking the View Personnel icon will pop up the 
staff list. Select a staff member and click 
View/Edit to make changes. 
 

! New staff may be added by those with administrator 

level access, under; Tools-Options-Administrator-
Personnel. You can also edit staff from the Browse screen 
by choosing View-Personnel. 
 

 
Editing cath data 

To edit an existing cath report; 1) click on the Edit Cath Report icon, 2) double click on the cath date 
in the cath list or 3) click the Edit Cath button below the cath list. 

 
Adding a new cath  
To create a new cath report; 1) click on the New Cath Report icon, or 2) click the New Cath button 
below the cath list. 
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The Edit Cath Screen 

 

 
 
Demographic information 
In the previous section we used a pop-up window to add and edit patient information. These same fields may 
also be edited in the top two lines of the Edit Screen. 
 
Case information 
The case information frame includes cath date and number; access notes, height and weight; as well as contrast, 
radiation dose and fluoroscopy data. The only required field is Cath Date. (Cath Number and Account Number 
may be required depending on your export settings). The Vein/Artery access locations and sheath size can be set 
by clicking the Set Access button.  The access locations are chosen from an option list. If there is more than one 
access site or sheath used, enter the one with the largest sheath size using the selections provided, and use the 
override boxes to set the text as it should appear on the report.  Closure methods can be entered here as well; 
those are part of IMPACT data collection and are not currently included with the PedCath report. 

 
Adding cath personnel and their roles 

 
Add personnel to this cath by clicking on the Add Personnel to Cath Report icon.  

 
 
Delete personnel from this cath by clicking the corresponding row in the grid and clicking on the 
Remove Selected Person from Cath Report icon. 
 

 
To change the role of the staff member, either double-click on the role, or click once and then click on the gray 
box on the right hand side of the field.  A drop down list will appear with the roles at your hospital.  
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Hemodynamic Sets 

! You can use the Tab key 

to move logically through 
the data entry screen. 
Pressing Tab will move to 
the next field while Shift-
Tab will move to the 
previous field. Try it! 
 
Although the top half of the 
edit window stays the same for an entire cath report, the bottom half changes with each set of hemodynamic 
measurements.  Up to eight hemodynamic sets can be associated with a single cath.  The name of the set may be 
selected from the drop down box on the left hand side of the screen.  This will contain common conditions that 
your hospital uses to gather hemodynamic data.  You may also manually enter a condition by double-clicking 
this box and typing the name.  Add or delete sets by clicking on the buttons below the set name.  When deleting 
a set, a dialog box will pop up to confirm the deletion. 
 
Calculated values 
  
Calculated values are shown in the lower 
left-hand corner of the edit screen.  Clicking 
the “View Calculations” button displays a 
window with all formulas and calculations 
displayed.   
 
Any default value used in these calculations 
can be changed by clicking the Calculation 
Override button and changing the 
appropriate values in the window that 
appears (right).  
 
Oxygen consumption calculator 
 
You may enter a value for Oxygen Consumption, 
leave the field blank or you may use PedCath’s built 
in oxygen consumption calculations: 
 
Assumed O2 by LaFarge method 
The LaFarge method uses patient gender, age, and 
heart rate to calculate an assumed oxygen 
consumption.  The LaFarge method is only 
available for patients between the age of 3 and 30. 
 
Indexing a measured value: 
If you use a measured value for oxygen consumption (ml/min), the calculator can use the stored value for Body 
Surface Area to compute an indexed value (ml/min/m2).  When you open the calculator, the BSA value will 
automatically appear as the divisor for the oxygen consumption calculation.  Patient height and weight are used 
to calculate BSA. If height and weight data should change, you must re-calculate the value for oxygen 
consumption. 

 
Age default: 
If your institution has set up a list of age-based defaults to use, and the patient falls within one of the age ranges, 
the default value will be shown.  Age-based values can be useful for patients under 3 years old, when the 
LaFarge method cannot be used. 
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User Fields 
 
PedCath intentionally limits the number of reporting 
sites in the interest of brevity and clarity. Pressures 
and saturations not listed in the site grid can be 
reported in the comments section and/or added to the 
diagram. 
 
PedCath now offers eight additional sites. Four fields 
can be configured to store data on four additional 
sites for every cath performed in your lab. Also, four 
patient specific sites may be used to record sites 
specific to the current case.  

 
 
 

 
 
Measurements 
 
A new group of measured values is available in 
PedCath.  
 
Review the default settings under  
Tools>Options>Administrator>Calculations  
to set global values for your institution. 
 
 
 
 
 
 
 
 
 
Qep  
 
PedCath can calculate, display, and print QEP values.  
In the browser screen, go to Tools>Options>User and  
click on the calculate QEP checkbox to turn QEP calculations  
on or off.   
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PedCath Options 
 

From the Browse Screen, select Tools>Options to open the options screen 

 
General Tab 
Allows the user to set guidelines for the destination 
folder for exported files, temporary file storage, 
diagram previews and startup options. 

  
User Tab 
Options include calculation of QEP, whether or not to 
use smart name and/or date formatting, choice of the 
email address book, and whether or not to use the 
original or Anderson Mullins and Mayer Atlas 
nomenclature. 
 
The user password may be changed under this tab as 
well. 
 
 

Global Tab 
Personnel roles may be added, deleted, or their 
rankings changed under this tab.  Which staff roles will 
be included on the cath report and which will be 
authorized to lock a cath may also be determined here. 
 
 

Administrator Tab 
Administrative options under this tab include the 
editing of personnel information, guidelines for 
calculations, institutional sites for saturations, and 
import and export controls.  
 
The Administrative Console may also be opened under 
this tab (see page 23), allowing the performance of 
database maintenance procedures. 
 
In addition, guidelines for cath report locking, participation in collaborative studies, and the assignment of cath 
numbers (including the auto-increment feature) may be applied here. 
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PedCath Imports 
 
Overview 
If your institution is licensed to use the PedCath Direct Data Import interface for your Cath Lab, you will be 
able to import patient demographics, case, and hemodynamic data as well as the procedure log and any 
available angio/snapshot images directly into PedCath from your hemodynamic monitoring system. 
 
The cath report should not exist prior to import; it will be created during the import process. PedCath8 however 
does give you added flexibility to run the import at any time into an existing case to bring in select components 
(see the Import Into an Existing Cath section).  
 
You are always free to create and edit case data manually, whether it is brought in with the Direct Data Import 
Utility or not. 
 
Please note the following sections show the interface with the GE MacLab.  The interfaces have minor 
differences, but largely work in the same way. 
 
 
Running the Direct Data Import Utility 
 

  From the PedCath Browse screen click the Import Data button on the toolbar, or choose Tools > Import 
Cath Data (F4) from the main menu. 
 
 
The Direct Data Import Utility screen will 
show a list of cases that have been sent to 
the Import folder from your hemodynamic 
system.  
 
Any entries that show up in red have 
already been imported and cannot be 
imported again.  (the administrative Import 
settings will allow you to configure  
whether files should be deleted or renamed 
after they are imported so that they will no 
longer show in the list – cleaning up the 
files will also greatly speed up loading the 
Import Module). 
 
Any entries that show in yellow should be 
checked to see if the patient’s 
demographics (Name, Birth Date, MRN) 
in the hemosystem exactly match what’s 
currently in PedCath. Double click the 
entry to see what fields do not match. 
 
PedCath8 will allow you  to import more 
than one case per day for a given patient. 
 
 
 
 
To start the import process, highlight a patient’s case in the grid and click View Data. This will bring up the 
Import Review screen. 
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Import Review Screen 
 
The Import Review Screen will show you what will be brought into PedCath during the import. You will have 
the chance to choose the best hemodynamics to bring in for the case, map staff to PedCath staff records, and 
selectively import case data, documents and images. 

! You have control to set any grid cells that have a white background; the cell values will determine what data 

will be brought into PedCath and what fields they will be stored in.   
 

! Any rows with blank white cells will not be brought into PedCath. 

 
 

 
 

Hemodynamics 
The first two columns of the Hemodynamics grid show the field names and data values taken from your 
hemodynamic system. The third column “PedCath” shows what fields the import data will be saved to in the 
PedCath database.  
 
Because PedCath stores summary data and not every measurement taken, you must choose the best 
hemodynamic measurements to bring into PedCath, if more than one measurement was taken for a site per 
condition. By default PedCath will choose the last measurement taken.  
 
To choose a different measurement, click the cell within the “PedCath” column and choose the field name 
where the data should be mapped from the drop-down list. Any other measurements taken for that field will be 
cleared for that hemoset. 
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For example to bring in the first RV pressure rather than the second, choose RV Pressure in the pull down menu 
next to the first RV measurement: 

 
 
PedCath will allow you to bring in at most eight hemodynamic sets. If there are more you must choose what 
sets to exclude from the import by highlighting a row within that set and clicking Unmap Set. 
 
There are some measurements that PedCath stores per hemoset that may have been measured at multiple sites 
during a case condition (such as the heart rate or blood gases). Depending on your hemodynamic interface, 
PedCath will allow you to choose the site to take the measurement from, in a pop-up list. If you see a box with a 
“…” next to the measurement when you click the row, clicking the button will bring up the list of site 
measurements to choose from. 
  

 
 
 

 
 



Using PedCath Page 13 of 32 

Staff 
When you first start using the PedCath Direct Data Import Utility, the Initials and Role columns will be blank.  
You will need to associate those columns with the staff name and role in the first two columns, in order for 
PedCath to import the staff members.   
 
To do this, expand the drop down list to find the users login (usually their initials) in the “Initials” column. 
Their default PedCath role will populate the “Role” column automatically. If this is not the correct role for the 
case, choose their role in the drop down list in the “Role” column. 
 
PedCath will remember your choices for future imports.  
 

 
 
 

Document and Image Resources 
The document and image resources group shows what resources will be brought into PedCath. Documents will 
be saved to the Document Manager, and images to the Image Manager. If a resource is unchecked within the 
Import column, it will not be brought into PedCath. 
 
You can view a document or image by highlighting it in the list and clicking the document/image icon on the 
right side of the screen. 
 
You are also free to edit the document or image titles by double-clicking the cell within the “Title/Description” 
column. 
 

 
 

Import 

 When you have had a chance to review the import data and all of the mappings look good, click 
the Import  button. 
 
A new cath report will be created in PedCath, and will be highlighted on the Browse screen. 
 
If you find particular measurements are not coming over or you would prefer certain measurements to be 
mapped to a different field, contact your PedCath administrator to work with Scientific Software Solutions to 
resolve the mappings. 
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Importing into an Existing Cath 
 
PedCath will allow you to import data into an existing cath report as well.  
 
Importing into an existing case could be useful for a number of scenarios: 
 
         - When you would like to work on the case diagram before the initial import. 
 
         - When importing documents/images that were not available when the case was first imported. 
 
         - Reimporting the hemodynamics, or any other section, and not having to delete the case and start over. 
  
To load data into an existing case, load the Edit Screen for that case and from the main menu choose  
 
 File > Import Into Current Cath  
 
This will load the Direct Data Import Utility, with only matching cases showing, if any. 
 

- Highlight the case and click View Data 
 
 
This will show the Import Review screen, but with check boxes next to each report section.  All sections are 
unchecked by default. 
 
 
-   Check off the sections that you 
want to bring in (Cath Data, Personnel 
Data, Hemodynamic Data, and 
individual documents and images.) 

 
- For the Cath Data and 
Hemodynamic Data sections, set the 
Overwrite mode as desired: 

- Fill Empty Fields:  This will 
bring data into fields that are 
blank in the PedCath 
database, and will leave 
existing data alone. 

- Overwrite All : This will 
overwrite all data whether 
something is there or not. 

 
 
All personnel records are added as new records; the existing personnel records are left alone.  
 
The same is true for documents and images – all are added as new resources.   
 
The number of hemodynamic sets must match what is currently in PedCath  (or otherwise no hemosets should 
exist in the existing PedCath record). 

 
 
 

   Click Import  to import the data into PedCath. 
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PedCathPedCathPedCathPedCath Exports 
 
Overview 
PedCath has a wide array of export capabilities to externalize the cath report data once it is completed. You can 
configure PedCath to allow manual exports and/or automatic exports when a cath report is saved or locked in a 
variety of both visual and data-driven formats. 
 
Export Protocols 
Files (Windows Sharing) – You can save the PedCath report data to one of several file formats. When running 
automatic exports you can specify local or shared network locations for the file(s) to be saved to. See the next 
section for supported file formats. 
 
Print  – PedCath will allow you to print the report to a printer attached to your local computer or network.  
There are many options to configure what is printed on the report.  
 
FTP – You can send the PedCath report in any file format via the File Transfer Protocol. This can be done both 
manually and automatically when a report is saved or locked.  When configuring the FTP setup, you have the 
option to strip patient identifying data if the files are to be exported outside of your organization.  SFTP is also 
supported (over SSH-2) and is recommended when sending data with patient identifying information to outside 
of your institution.  
 
Email – We support any MAPI-enabled mail client and will load your default mail client with the PedCath PDF 
report as a mail attachment. 
 

Supported File Formats 
HTML (.htm) – PedCath can generate the report as a hypertext document that can be displayed within any web 
browser. 
TEXT (.txt) –  PedCath can export the report to a simple ASCII-format text file for simple parsing or backup. 
PDF (.pdf) – PedCath also supports Adobe’s PDF document format. Files of this type have the advantage that 
they cannot be altered and preserve the original page layout when printed or viewed on different platforms. The 
PDF export has many configuration options that can be set during the report setup. This is the format PedCath 
uses for printing. 
 
Optional Formats 
XML/XSL (.xml / .xsl) –  PedCath can write the report data in XML format, which is becoming the standard for 
data exchange between systems. We also export an XML stylesheet file (XSL) that presents the XML data in a 
web page format. If our PDF document or our XSL style sheet does not suit your needs for the printed report, 
your organization can develop its own XSL file to define the presentation of the XML data.   
http://www.w3.org/Style/XSL/ 
  
As of version 7.5.5, we have released version 2 of our XML format that is more inclusive of the report data and 
better suited for data exchange. Because it is written primarily for data exchange it does not currently include a 
style sheet for presentation. 
 
You can configure which version to use in the export administrative options. 
  
HL7 – PedCath can write the report in the industry standard Health Level 7 format.(v2.3.1). 
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Manual and Automatic Export 
PedCath allows you to configure which exports 
PedCath users may export manually and which 
ones will be automatically exported when the cath 
report is either locked or saved. 
 
For manual exports you can also force the user to 
enter their user name and password before they can 
export. 
 
For automatic exports the default path is set to the 
export\ folder within the PedCath network 
directory. Each user has the choice to use the 
default path or set it to a different location. 
  
You can also define the file name format for the 
automatic exports by combining fields such as the 
MRN and cath number. 
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Cath Report Component Managers 

! The six buttons (shown at right) launch (left to right) the 

comments, diagnoses and procedures, adverse events, and the 
diagram, image, and document managers.   

 
 

Comments 
Comments may be edited by selecting the comments button 
on the toolbar, pressing F2, or selecting “Comments…” from 
the view menu.  This is the best place for short notes. For 

longer commentary, entire documents may be added to the report. 

 
 
Diagnoses and Procedures 

 
 The diagnoses coding screen may be activated by selecting the Dx button on the toolbar, pressing 
Ctrl+D, or selecting Diagnosis and Procedures from the 
tools menu. 

 
To add a code, you may either browse through the Code Set box or 
use a search facility. 
 
In the Code Set box, expand the folder list by either double clicking 
on a folder or clicking on the + sign to the left of the folder you wish 
to open.  Select a code by clicking on it.  To see the full name of long 
descriptions, use the scroll bar at the bottom or leave the mouse over 
a description for a few seconds; in the latter case, the full name will 
appear momentarily.  To add a code to the cath, use either the Add 
button or double click on the code.   
 
To add a code via the Search for Code box, enter a code in the small text box on the left.  If this box matches a 
code exactly, the code is displayed in the text box immediately to the right.  Click Add to add this code to the 
cath.  Notice the Copy List button to the right of the Selected Diagnoses and Procedures list.  This will allow 
pasting of the selections under Comments or into another document. 

! You can add a code via the Search by Name box. Just enter a part of the name of the code for which you 

are searching.  For example, entering stra, the selection box will list all diagnoses that contain the letters “stra” 
in order, such as “00105. Stradling mitral valve,” and “00106. Stradling tricuspid valve.”   
 
Select Dx. codes by double clicking or highlighting and pressing the Add button. 
 
You may remove a patient’s Dx. codes by highlighting them, then clicking the Remove button. 

! You can change the position (order of importance) of a selected code by highlighting it and then clicking 

the up and down arrows in the Rank box to the right.   

 
Click the “Set Status Post” button to mark a procedure as status post. Procedures imported from earlier cases 
will automatically be set to status post.  This option is not available for all coding sets. 

 
Adverse Events (Optional) 
Adverse Events is an optional button. If activated, this button will open the Adverse Events screen.  This will 
present the Adverse Events code list and relevant qualifiers. 
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Diagram Manager 
 
 To access the diagram manager, press F6, 
select “Diagram Manager…” from the Report 
menu, or click on the Diagram Manager 

button in the upper right of the edit screen. 

In the Report Diagrams selection box in the upper left 
of this window, you may select the diagram you wish to 
view.  A preview will appear on the right.  Each 
diagram may be associated with between zero and four 
hemodynamic sets.  Click the check boxes of the hemo 
sets which you would like to associate with each 
diagram.  To remove a diagram, click the button 
marked with an “X.”  To add a new diagram, click on 
the Add Diagram button, the button marked with a 
folder on the far left of the toolbar. 
 
Adding Diagrams 
To add a diagram, expand the folder list by either 
double-clicking on a folder or clicking on the + sign to 
the left of the folder you wish to open.  Select a heart 
description by clicking on it; a small preview will 
appear on the right.  To see the full name of long 
descriptions, use the scroll bar at the bottom of the 
folder list or leave the mouse over a description for a 
few seconds; in the latter case, the full name will appear 
momentarily. 
 
For most of the original diagrams there are variations 
available (such as adding an LSVC to the Left Atrium, 
LSVC to the Coronary Sinus, or Right Aortic Arch). To 
choose a variation select one of the choices within the 
Diagram Modifications group. You can also choose to 
use a wider version of a diagram that shows expanded 
pulmonary arteries, by clicking the Wide version box.   
The Mirror diagram box will flip the diagram horizontally for Dextrocardia patients.  
(Note: If the diagram modifications are greyed out, you may be missing the new diagrams. Click the Update 
Atlas/Supplement button to install the latest diagrams 
from the web or from a PedCath CD). 
  
Once you have chosen the diagram that best matches 
the patient, click the Select Diagram button at the 
bottom of the form, and the diagram will be added to 
the cath. 
 
On the Other Diagrams tab you can create an additional 
atlas of diagrams for your institution. You can add 
diagrams to the User Atlas from a file or from the 
current patient’s template. To add the patient’s template 
to the User Atlas, click the Load Template button and 
then Add Template to Atlas. To load the template 
directly to the cath report, click the Load Template 
button and then the Select Diagram button.  
 
We provide an atlas of supplemental diagrams preloaded into the user atlas, that includes surgical and device 
implantation diagrams. (You can see if your supplement is up to date by running the Update Atlas/Supplement 
module). 
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Editing Diagrams 
To edit a diagram, click on the pencil icon in the toolbar 
in the diagram manager or double click on the diagram 
you want to edit.  This will activate the drawing screen. 
 
The PedCath drawing program is specially designed to 
help you produce anatomical diagrams for your cath 
reports.  The drawing tools are easy to use, and should 
look familiar to anyone who has used other Windows 
drawing programs.  Hemodynamic data appears in a 
table next to the picture, allowing you to drag numeric 
values directly to the diagram. 

! If you make extensive changes to the patient 

diagram, you may wish to save the diagram as a template by clicking the Save Template button. This option 
will save this diagram for this patient, allowing it to be recalled in the future. Each patient may have only 
one template. 
 
 

 
Embedding Hemodynamic Values in the Diagram 

You may automatically embed all hemodynamic values from the data grid to the diagram.  Values embedded in 
this way will appear at the appropriate places in the anatomy image, and will use the same automatic formatting 
features as when the same values are manually inserted.  The Undo feature does not apply to embedded data; 
however, you may cancel an embed operation by closing the edit diagram screen without saving. 
 
 
Edit Diagram Toolbar 
The Edit Diagram toolbar contains options for 
adding various elements to a patient’s diagram: 
hemodynamic data and other text, as well as 
arrows, lines and shapes. Each element that you 
add to the diagram is called an object. Use one of 
the six drawing tools to add or edit objects on the 
diagram.  Each of the tools has specific options, 
which are displayed below the toolbar.   
 

Undo Create Object 
Click this icon to undo the last drawing 
operation. 

 
Flush 
After you have added drawn objects to 
the diagram, they can be moved or 

edited individually until you either save the 
diagram or press the flush button. Although flushing does not save the diagram to the patient’s cath record, 
flushing the objects in the diagram makes them part of the diagram bitmap; they no longer exist as separate, 
editable elements.  After an object has become part of the drawing, you can modify that object only by drawing 
over it.   
 

Selection Tool 
Use the selection pointer to select objects for editing or deletion.  Only objects added to the diagram in 
the current editing session may be selected.  After you have clicked the selection tool, the mouse 

pointer will change to a bull's eye when it is over a selectable object.  Click in the drawing on any object.  A 
box will appear around it indicating that you may use one of the drawing tools to change it, or drag it to a new 
position on the diagram.  To delete a selected object, press the Delete key.  You may also select an object by 
right clicking on it with the mouse, even if you have not previously chosen the Selection Tool. 
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Text Tool 
Choosing the text tool shows a text box where you may enter a string of characters to be placed on the 

diagram.  Select a font and other formatting options, and then click on the diagram where you want the text to 
appear. If you click on any value in the hemodynamics tab, that figure will appear in the text box.  You may 
format it as you would any text, and click on the diagram at the appropriate location.  You may also pre-set the 
formatting options, and drag numbers onto the diagram with the mouse.  Automatic formatting, such as the bar 
over mean values, will override your formatting when you use the drag and drop method. 
   

Freehand Tool  
Draw freehand lines and shapes using the freehand tool.  Set the line color and thickness, and then drag 
the mouse on the diagram while holding down the left button.   

! Drawing with any tool in white works as an eraser.  

 
Line Arrow Tool   
Draw straight lines and arrows with the line tool.  To draw a line, click at a starting position on the 
diagram and hold the mouse button down while you drag to the point where you want the line to end.  

Release the button to place the line on the diagram.   Arrows are useful for indicating the catheter course.  
Select a size for the arrow’s head, and draw a line.  You may place the arrowhead at the beginning or the end of 
the line. 

 
Rectangle, Ellipse, and Blob Tools 
 Use one of the three shape tools to draw enclosed shapes on the diagram: (left to right) 

rectangles, ovals, or irregular shapes (blobs).  For each of these shapes, set a Line Color for the outline, and a 
fill color for the enclosed, inside area.  You may also select a fill pattern; for non-solid patterns, the transparent 
option will allow the diagram beneath your shape object to show through. 

 
Tip: The blob tool is useful for drawing in stents by tracing an outline of each stent along the walls of an 
artery. Try using a diagonal crisscross Fill Style, and a transparent Fill Mode. 
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Image Manager 
To activate the Image Manager, click on the camera 
icon in the Report Component Manages window. You 
can also launch the Image Manager by pressing F7 or 

selecting “Image Manager…” from the Report menu. 
 
The image manager allows you to add images and captions to 
the cath record. To add an image, click on the folder icon in the 
image manager.  A window will pop up allowing you to find and 
select an image to attach.  A caption may be entered in the text 
box along the bottom of the image.  To remove an image, click 
on the button with an “X,” just to the right of the Add Image 
button.  When multiple images are associated with a cath, 
previews of the images are displayed along the left and right 
margins of the image manager window.  To view an image in a 
larger size, click once on it, and the yellow cursor will surround 
the preview of the image. 
 
To swap two images, click on one of the two images you would like to switch.  Click on the third button from 
the left, and, following the on-screen instructions, click on the second image you would like to swap. 

 
You can also import images directly from the Windows clipboard.  
 
 

 
These options will allow you to shrink the resolution or change the format of images currently in 
the database, or set up to have image modifications applied automatically during imports. This can 
be helpful to conserve disk space. 

 
 
To edit an image select it within the Image Manager 
Window and click the Edit Image button. The Image 
Editor (shown right) allows you to draw lines, shapes 

and text similar to how it is done in the in the Diagram Editor 
(see previous section for more details). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
PedCath will allow you to select which images appear on the cath report on the Report Setup dialog (see the 
Report Setup section, page 25). The report image selections will be retained for each cath report.  
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Document Manager 
To show the document manager, press F8, 
select “Document Manager…” from the 

support menu, or click the Document Manager button 
from the upper right corner of the edit window. 
 
The Document Manager enables you to import 
existing documents into the report or create new 
ones.  You may also open, modify, and delete 
documents using the Document Manager.   
 
When you click Import File, you may browse and 
select the document you wish to import.  You may 
import documents in the following formats: *.rtf, 
*.txt, *.doc, *.htm, and *.html.  PDF files are also 
supported for import, but as read-only documents. 
 
Clicking Create New Document will open the 
Document Editor (below), which allows you to create 
documents containing tables and images.  
 
There is a preview of the document that is currently selected in the lower left window. You can edit an existing 
document by clicking this window or by clicking the Edit File button. 
 
The Document Manager also allows your institution to keep a Document Archive to pull related documents into 
the cath report (to be used as templates, for example). The documents listed within the My Cath Documents tab 
can be seen only by you, and those listed under Network Documents can be seen by all PedCath users. We 
provide over 20 documents for the institutional document archive to get you started.  PedCath administrators 
can modify the hospital-wide archive. 
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Edit Cath Report Screen Toolbar 

 
 
The six icons on the toolbar in the upper left of the Cath 
Report Screen (left to right) return to the Browse Screen, save 
changes, launch patient billing information, launch the report 
set-up, provide a print preview, and open help information.   
 
 
 
 
 
 
 
 
 
 
Billing Information 
 

To access patient billing information, press Ctrl+B, click the Patient Billing Information button on the 
toolbar, or select “Patient Billing Information” from the tools menu. 
To add a code, you may either browse through the All codes box or use a search facility. 

 
In the All codes box, expand the folder list by 
either double clicking on a folder or clicking 
on the + sign to the left of the folder you wish 
to open.  Select a code by clicking on it.  To 
see the full name of long descriptions, use the 
scroll bar at the bottom or leave the mouse 
over a description for a few seconds; in the 
latter case, the full name will appear 
momentarily.  To add a code to the cath, use 
either the add button or double click on the 
code.  If a code is added to the active cath 
through these methods or the others discussed 
below, it will be displayed as bold in the All 
codes box. 
 
To add a code via the Search by Code box, enter a code in the small text box on the left.  If this box matches a 
code exactly, the code is displayed in the text box immediately to the right.  Click Add to add this code to the 
cath. 
 
To add a code via the Search by Name box, enter a part of the name of the code for which you are searching.  
For instance, if you enter sed, the selection box below will contain any code name that contains the letters “sed” 
in that order, such as “Conscious Sedation, IV (99141),” and “Conscious Sedation, PO (99142).”  Select the 
code that you wish to add and press the Add button. 
 
In the “Codes for this Cath” box, you may change the number field by clicking the up and down arrows in the 
Count box to the right.  You may also remove codes by clicking the remove button. 
 
To add the -22 modifier to a billing item, select it and click the “-22” toggle button. 
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Locking the Cath Report 
 

PedCath has the ability to lock the cath report so that no edits can be made. To lock the cath report, 
click the padlock toolbar button or choose “Lock Cath Report” from the File menu (shortcut Ctrl+L). 
In order to lock a cath you must be a staff member listed on the cath report with a role with lock 

privileges (Attending’s only by default). Administrators can set the roles able to lock a cath report by choosing 
“Tools” > “Options…” from the Browse screen and clicking the Global tab.  
 
These members also have the ability to unlock the report within the following 24 hours after a lock to make 
changes. To unlock the report choose “File” > “Unlock Cath Report” from the menu.  After 24 hours this menu 
item will not be available and you will need to create an updated report described in the next section. 
 
The staff member who locks the report is essentially saying the report is complete and thus signs off on it. The 
report printout will specify that this staff member signed the report. 
 
Administrators can decide whether PedCath users can print preliminary reports and if so the text that will be 
printed on it to indicate that it is unsigned.  To configure this option “Tools” > “Options…” > “Administrator” 
and click the “Report Locking” link. 
 
Auto-export can be configured to trigger either when the cath is saved or when it is locked (default). 
 
 
Creating Updated Reports 
 
If it is required to make changes to the cath report after the grace period of 24 hours, PedCath will allow you to 
create an updated report to work from so that the original report will remain unaltered. To do this choose “File” 
> “Create Updated Report” from the menu. You are able to add, delete, or modify anything within the updated  
report including resources such as documents, images, and diagrams.  
 
You can make as many updated reports as necessary and older updated reports or the original report can be 
viewed from the “View Backup Cath Report” item on the “File” menu.  If you print an older report there will be 
a message on the printout saying that a newer report is available. 
 
If the report you are editing or viewing is an updated report, a message will be shown in the status bar and a 
message will be printed on the report saying so. 
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Report Setup 

 
 To setup, preview, and print a cath report, press 
Ctrl+R, click the Report Setup button on the toolbar, 
or select “Report Setup…” from the Report menu. 

Reports can also be printed from the Browse screen in the 
same manner. 
 
On the Components tab select the items you wish to include in 
the report.  A check box is grayed if the associated cath 
component is not available for the current cath report.  For 
instance, if there are no images, the Images check box is 
grayed; if you do not check the Documents check box in the 
Components box, each individual document’s check box will 
be grayed in the Documents box. 
 
In the Images box, you may select the layout of the images.  
Clicking the Select Images button will allow you to choose 
which images to include in the report, and optionally retain 
those choices for future printouts. 
 
On the Options tab you can select many report setup options  
such as the page number location, the caption to be used for 
diagrams, if any, as well as the ability to hide null calculations 
or blank grids, or replace the calculation block with the 
hemoset grids (if more than one hemoset is shown on the 
page).  
 
By clicking the “Diagram/Hemoset Options…” button you can 
specify which diagrams are to be printed and if summaries of 
all associated hemosets will be printed on each summary page 
or just one expanded set. 
 
The “Dx/Comment Options…” will give you control over 
inclusion and positioning of the diagnoses, diagnoses’ 
comments, and cath comments. You can choose to roll the cath comments to the second page for instance, or 
choose to print the Dx comments rather than the Dx procedure list. 
 
 
 
 
 

 
You may preview your report by clicking the Preview button. 
 
 
When you are satisfied with the appearance and content of your cath report, press the Print 
Button and select the number of copies you wish to print. 
 
 
You may also save the report in one of several formats; including ASCII, HTML, PDF, 
XML, or HL7. The PDF file will look the same as the printed report and uses the options set 
from the report setup. You can also email the PDF report by clicking the ‘Send…’ button, or 
manually send the report via one of the FTP profiles set by your institution. 
 
  

 
 
You may optionally save your report settings so that the next time you go to print a report 
the settings will load the same way.
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Data Reports 
 
PedCath includes a data reporting tool that can be used to create reports based on criteria (query items) 
specified for your cath database. For example, a report could display all the caths where the patient was less 
than 7 days old, or list all the patients with Tetralogy of Fallot where Dr. Everett was the attending physician. 
Once the report query is run, the report will be created as a PDF document that can be printed, saved, or 
emailed.  
 
The Data Reports module has been rewritten in version 8.1. New features include a user interface overhaul, 
expanded data fields (including hemodynamics and IMPACT Registry data),  and the ability to load the query 
results into the PedCath Browse screen.  
 

 
Creating a Report Query 

 
On the PedCath main screen (Browse screen), click the Tools menu and choose “Data Reports…”  The “Data 
Reports” dialog will be displayed. Criteria may be entered here to filter for the desired records. 
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Let’s say we want to create a query for all cath records for 
patients less than 3 months old where Dr. Everett is the 
attending physician.  
 
In this case we would need to create two query items – one 
for Dr. Everett being the attending physician and the other 
specifying the age to be less than 3 months.  
 
To do this expand the Staff entry tree group in the Cath 
Data tree by clicking the + next to it and check off 
“Allen D. Everrett, MD”.   
 
The Query Field pop-up will be displayed.  
 
Leave the query type set to “Is Any Of:” and check 
“Attending”   
 
Click Set Query to confirm the query. 
 
 
 
 
 
The query item will be added to the Query Summary 
area at the bottom of the screen.   
 
 
 
 
To add the query based on the Age at Cath, check the 
“Age at Cath” item in the Cath Data grid.  Choose 
“Is Less Than” as the query criteria, enter “3” in the 
text box, and select “Months” from the units drop-
down box.  Click “Set Query”, and the query item 
will be added to the Query Summary. 
 
 
 
 
 
 
 
 
 

 You can edit a query item’s criteria, by double-clicking the field name the query trees (and not the check 
box) or by highlighting the item within the Query Summary area and clicking the Pencil icon (or by double-
clicking the query item). 
 

 You can delete a query item by unchecking the box next to the field name in the query trees, or by 
highlighting the item in the Query summary and clicking the X button (or the pressing the Delete key).  
 
 
Note: A query can be saved for future use by clicking the Save button, and a previously saved query can be 
loaded by clicking Load and finding the query file (p8q extension). Please note this file contains the query items 
and report setup but does not contain the results of running the report. 
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Running the Report Query 
 
Make sure to specify if you are searching “By Cath” or “By Patient”. If searching by Patient, the results will 
show a list of Patients who have at least one cath that matches the query. 
 
From the “Data Reports” dialog, click the big “Run” button to run the report query. Processing times can vary 
depending on the size of the cath database, complexity of the query, and speed of the network. 
 
If we run the query entered in the previous sections on the sample data set, 2 cath records are returned as shown 
in the figure below. 
 

 
 
 

Clicking the Preview or Print button will allow you to view/print the results report. You can 
order results rows by clicking on one of the column headers (click a header multiple times to 
toggle between ascending and descending order). The printed report will be in the same 
order. 
 
 
 

 
Clicking the Save As button will allow you to save the report in .CSV format, which can be 
opened and further processed in Excel or other spreadsheet programs. By default the fields 
shown in the grid will be included in the .CSV file, but you will be given the option to 
include additional patient, cath, and staff fields. Additional processing will be required to 

search the database for the additional data.  
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Clicking the Load in Browse Screen button will open the Browse screen showing only the 
patients returned in the query results. Here you will be able to further inspect any of the 
cases returned by the query, and make any changes to any cath reports if necessary. If you 
did a Search By Cath, then only the patient’s caths that matched the query will be shown in 

the Cath grid. To view all of a patient’s cases whether they matched the query or not, check the “Show All 
Caths” box. 
 
Viewing by cath (View > By Cath) is supported while in query mode, but viewing by staff is not. 
 
 

 
 
 
You can make modifications to the query by clicking the Edit Query button.  
 
Click the X on the right side of the yellow header bar to close the Query Results View and show all of the 
PedCath patients. 
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 Administrative Console 
 
The Administrative Console is a separate application from PedCath that contains many administrative features 
such as viewing login information, viewing access log information (HIPAA logging), running database 
maintenance and modifying the staff database.  
 
You can start the Administrative Console from the start menu or within PedCath. 
 
To start from Windows: 
  Start >> Programs >> PedCath >> Administrative Console 
  You will need to enter your PedCath initials and password to log in. 
 
To start from within PedCath: 
  On the Browse screen choose: 
  Tools >> Options … >> Maintenance >> Run Administrative Console 
  You will be prompted to close PedCath if you plan on running the database maintenance utility. 
 
 
Editing Personnel 
 
The first tab contains the PedCath staff listing for your organization. 
Here you can add, remove, and modify staff members. The staff listing 
may be edited within PedCath as well (see the installation guide for 
more information on these options). 
 
 
 
 
 
 
 
 
 
 
 
Viewing HIPAA Logs 
 
On the second tab you can view HIPAA logging information such as 
when patients’ records were browsed or edited and by whom. This 
information can be seen by selecting a filtering option and clicking the 
“View HIPAA Log” button. For instance, to see a listing of when a 
particular patient’s cath information was viewed or edited click the 
“View by Patient” option and then the View HIPAA Log. 
 
  
The View HIPAA Export feature works similarly except that it displays 
information related to exports and cath report locking. The last filter 
option “View by Export Action” is applicable to this feature and will 
allow you to search for a particular action type that happened, for 
instance a listing of all the cath reports printed. 
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Maintenance 
 
The Maintenance table contains many features necessary to 
maintain the PedCath databases. The most important of these 
features is the Database Maintenance wizard which is described in 
the next section. 
 
You can also set up database maintenance reminders within the 
Scheduled Maintenance grouping. 
 
There are several options beneath the Other Maintenance group. 
These options are likely to be used rarely but are necessary in 
certain circumstances. 
 
Disconnect Data Folder – This will remove the pointer to the 
PedCath database and it will have to be set the next time PedCath or the Administrative Console is run. 
 
Clear Version Data – This will clear the version information from the database making it possible to revert to 
an earlier version of PedCath. 
 
Clear DB Version Data – This will remove the database version number which will cause the database 
upgrade to run the next time PedCath is started. This can be helpful if the database upgrade needs to be run 
again or if you are reverting to an earlier version through a minor release (not recommended).  
 
Prompt for Code Set Sync – This will cause PedCath to check for code set (Diagnosis/Procedure set and 
Billing) differences between the “master” set on the network and the sets that are used on the current 
workstation the next time PedCath is run. 
 
Configure Network Redirector – This will allow you to set a database redirector to be used during database 
migration. All PedCath users who attempt to connect to the current path will be redirected to the new path you 
specify. 

Database Maintenance 
 
The Database Maintenance utility can be used to 
perform cleanup and integrity checks on your 
PedCath database. The picture to the right shows the 
maintenance options available. It is at least 
recommended to run the Indexes options which will 
rebuild the indexes in case they have become 
corrupted.  The Integrity Check is recommended as 
well and will verify that the ID table is valid. 
Although unlikely, if you encounter an integrity error 
contact Scientific Software.  
 
When records are deleted from a dbf table, the records are not actually removed but rather flagged for deletion. 
Under the Cleanup group checking the “Remove Deleted Records” option will actually remove all of these 
entries from these tables which will improve performance from smaller table sizes.  
 
Checking for orphaned records will tell you if there are any cath records without a corresponding patient or any 
cath sub-table records without a corresponding cath record. You should rarely find many orphaned records. 
However, if you find a large number contact Scientific Software for assistance. 
 
The final option “Remove All Record Locks” will remove all dBase internal record locks from the system as 
well as patient locks.  
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Viewing Login Information 
 
The fourth tab allows you to see who’s logged into the system and 
what patients are currently being edited. If you select a staff member 
and click “Log Off User” the user’s login record will be removed and 
the user will not be able to edit any more cath reports. Note that the 
users will still be in the system and connected to the databases, so if 
you want to perform database maintenance they will need to close 
PedCath. You can also remove a patient lock from a user by selecting 
his name and clicking “Remove Patient Lock”. The selected user will 
not be able to save any changes to the current patient. These options 
are also helpful for single-user licensed institutions when, for 
instance, PedCath is terminated abnormally (such as by a system 
crash) and the login information is still present causing everyone to 
be locked out.  


